a PaNpuIT company

OmniStream™

Single-Channel / Dual-Channel

Networked AV Encoder / Decoder

Solutions Setup and Configuration Guide

A-OMNI-232  A-OMNI-311 - AI-OMNIF111 - A-OMNI-121 | Atlona Manuals
AT-OMNI-324  AT-OMNI-112 - AT-OMNI-122 | Networked AV



a PaNpuIT company

Version Information

Version Release Date Notes

1 02/19 Initial release

2 03/19 Audio added

3 03/19 USB added

4 05/19 Added Network Switch Configuration, IR Control

5 09/19 Updated AMS, Updating Device Firmware, and Configuring OmniStream Devices
sections with firmware 2.5 screenshots




a PaNpuIT company

Table of Contents

Introduction 4
Getting Started 5
Selecting a Network Switch 5

AMS - Purchase or Download 5
Recommendations 5
Connections 6
Network Switch Configuration 7
Getting Started 7
VLAN Setup 9

IPv4 Interface Setup 12
Configuring IP Multicast 16
Creating User Accounts 22

AMS 24
Getting an IP Address 24

Login 24
Updating 25
Discovery 27
Updating Device Firmware 29
Configuring OmniStream Devices 30
Testing Connectivity 35
IR Control 36
Controlling the Display using the Display’s IR Remote 36
Required Equipment 37
Connecting the IR Receiver to the Encoder 37
Connecting the IR Emitter to the Decoder 38

Identifying the Encoder using AMS 39

Configuring the Encoder Serial Port 40
Configuring the Encoder Session 41

Configuring the Decoder Serial Port 43

Testing IR Functionality 46

Controlling the Display using a Control System 47

USB to IP Adapter 48
IP to Analog Audio Bridge 51
Video Walls 54



a PaNpuIT company

Introduction

This guide provides a base for setting up and configuring a small OmniStream™-based solution. The setup
instructions will provide information for building a system capable of sending and receiving audio and video through
OmniStream™ encoders and decoders, as well as a simple way to set up video walls and audio routing.

Media Player

Encoder

Network Switch

Decoder

A, »

Decoder

Display

Display

OmniStream




a PaNpuIT company

Getting Started

Selecting a Network Switch

A network switch will be needed to power and pass IP traffic. A list of certified switches is provided below with
download links for prebuilt configurations. Atlona recommends using a switch from the certified list to ensure
compatibility.

Certified Switcher Download Configuration

Cisco SG300-10MPP Box Download Link | The default configuration can be found within the

OmniStream Certified Network Switches document

Cisco SG300-28MP
Cisco SG300-52MP
Cisco SG350-10MP
Cisco SG350-28MP

Cisco SG350-52MP

Box Download Link
Box Download Link
Box Download Link
Box Download Link

Box Download Link

that can be found at https://atlona.com/pdf/
OmniStream_ Certified Switches.pdf.

Cisco SG550X-24MP Box Download Link

Cisco SG550X-48MP Box Download Link

Pakedge S3L-24P Box Download Link

Luminex GigaCore 26i Box Download Link
Ruckus ICX 7150-48ZP Box Download Link

Ubiquiti ES-48-500W /ES-48-750W | Box Download Link

AMS - Purchase or Download

For configuration of the OmniStream devices, AMS (Atlona Management System) will be needed. AMS has two
options: AT-AMS-HW hardware or AT-AMS-SW free software. AT-AMS-HW can be purchased at: https://atlona.com/
product/at-ams-hw/ or AT-AMS-SW free software can be downloaded from https://atlona.com/product/at-ams-sw/.
AMS will be needed before progressing further into setup and configuration.

Recommendations

If using multiple of the same OmniStream devices, or for reference, labeling can be used. It’s best to place the label
on the front of the device for visibility. When labeling, notate the last 4 numbers of the MAC address, found on the
bottom of the unit on the label, for easier IP discovery and notation later.

Use a component surge suppressor with line conditioning for best results.

IMPORTANT: Atlona’s warranty does not cover damage due to electrical disturbances. A component
surge suppressor with line conditioning is highly suggested, especially in areas with electrical storms.


https://atlona.com/product/at-ams-hw/
https://atlona.com/product/at-ams-hw/
https://atlona.com/product/at-ams-sw/
https://atlonainc.box.com/s/zxo0979vqcd2t4lelxe6ln82k7mvgizt
https://atlona.com/pdf/OmniStream_Certified_Switches.pdf
https://atlona.com/pdf/OmniStream_Certified_Switches.pdf
https://atlonainc.box.com/s/l0q7wxtnrckgr4clnl9k843ya4menolh
https://atlonainc.box.com/s/3ty9h2a2nl21csw2boa2tc0st9dxawao
https://atlonainc.app.box.com/s/rankeecnh9ey21gtrxrogkafvda2i6r8
https://atlonainc.app.box.com/s/zt893yn66iflnqctwcfsx2sc2z6rvpbh
https://atlonainc.app.box.com/s/mr18ycd1we66q5v4m2u1i4pjms1qqvzf
https://atlonainc.app.box.com/s/w2ux7ckmvd1ezsdk962nv49bxsk2sswu
https://atlonainc.app.box.com/s/o47er6etart69hxogl95c5rlzkdnp3sx
https://atlonainc.box.com/s/l8gl6566483jf5idrst9okv8qqfk16xu
https://atlonainc.box.com/s/gqdm9ulolk7mr4oxr6e28mc7xov9see4
https://atlonainc.box.com/s/cpzy20qmnfdbf8sg3gga27hgkca6ddvx
https://atlonainc.box.com/s/7mmkw4un41u77v0u7kxb6wp1ois02r5r
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Connections

Initial connections can be done without installing the devices in their final spots. Have at least one source and display
available to ensure video is passing between OmniStream devices.

1. Connect all devices to the network switch using a CAT5e or higher cable. OmniStream devices will need to be
plugged into the PoE ports.

2. Have at least one source and display ready to connect to any of the OmniStream devices.

3. *Optional* If using the AT-AMS-HW, connect it to the network switch.

4. Once all the devices are connected to the network switch, connect the switch power supply to the power strip.
5. *Optional* Once the switch is booted, connect the power supply to the AT-AMS-HW and power strip.

6. *Optional* If using the AT-OMNI-311, connect the USB B to USB A cable to the USB port of the PC, that will
provide the 5V power.

7. *Optional” If using the AT-OMNI-324, connect the power supply from the unit to the power strip.



a PaNpuIT company

Network Switch Configuration

Getting Started

Before working with the OmniStream devices, the network switch must be set up. This guide will provide instructions
for configuring a Cisco SG350X-24MP switch. The following steps will be the similar for most Cisco switches.
However, there may be small variations, depending on the switch model. Consult the switch User Manual for more
information.

IMPORTANT: The Network Switch Configuration chapter is divided into five sections. Each section
must be followed in the order listed below. Deviating from this order, or skipping steps within a
section, may result in unpredictable switch operation.

Getting Started

VLAN Setup

IPv4 Interface Setup
Setting IP Multicast
Setting up User Accounts

1. Connect a PC or laptop to the network switch. It is best to you whichever port will remain on VLAN1 of the switch
to avoid the PC losing connection when settings are changed on the switch.

2. Go into the computer settings and change the IP of the PC to be on the same range as the switch.

to 192.168.1.xx, where xx represents values from 1 to 253, as long as that IP address is not already

o NOTE: If the IP address of the network switch is 192.168.1.254, then the computer should be set
assigned on that network. The default IP address for all Cisco switches is 192.168.1.254/24.

3. Launch the desired web browser and enter the IP address of the network switch into the address field, then
press [ENTER].

alialn Switch
c15¢o Application
pascvors

‘Secure Browsing (HTTPS)

d.

are registered trademarks or trademarks of ¢ Systems, Inc. andior its affiliates in the

4. Enter the username and password. The default login credentials are as follows:

Username: cisco
Password: cisco

OmniStream 7



/N\T LOMN/.

a PaNpuIT company

Network Switch Configuration

5. Click the Login button.

The switch will most likely require a new password to be assigned, before going further. This step may vary
depending on the network switch. Enter the desired password, as required.

| Display Moce: R

-24MP 24-Port Gigabit PoE Stackable Managed Swit

Change Password

Flease change your passwerd from the default settings for better protection of your network

‘The minimum requirements are as follows:

« Cannot be the same as the user name.

- Cannot be the same as the current password.

«Minimum length is &

« Minimum number of character classes is 3. Cha
num

New Password Configuration
Qld Password:

New Password:

Confirm Password.

Password Strength Meter T ] s

Password Strength Enforcement Disable

ety ]

6. Click the Apply button to commit changes.

7. The Getting Started page will be displayed.

d - claco awichde6St5  Language: Disply Hode: Logout SNA  About Help
SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch I C.

Commasanes
Seing s

Configuration Wizards
This page provides easy steps to configure your device
> Stalus and Statistics
» Administration Sy Initial Setup . Quick Access

» Port Management Manage Stack Change Device Password
» Smariport

» VLAN Management
» Spanning Tree

> WAC Address Tables

Change Management Applications and Senvices Upgrade Device Software
Change Device IP Address Backup Device Configuration
Create VLAN Greats MAG-Based ACL
Configure Port Settings Create IP-Based ACL

»_IP Configuration Configure Qo8

» Security Device Status Configure SPAN

+ Access Gontrol
» Quality of Senvice

System Summary
Port Statistics
RMON Statistics
View Log

Other resources: S it| Forums

[J Do not show this page on starup

ms, Inc. All Rights Reserved

OmniStream
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Network Switch Configuration

VLAN Setup

8. Click the Display Mode drop-down list, near the upper-right hand corner of the screen, and select Advanced.

wlialn e e Display Mode: Logout SNA About Help
cisco SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch n Basic I

Geting Started

Configuration Wizards
This page provides easy steps to configure your device
+ Status and Statistics
T ~x  Initial Setup . Quick Access

» Port Management Manage Stack Change Device Password
Change Management Applications and Senices Upgrade Device Software
Change Device IP Address Backup Device Configuration
Create VLAN Creale MAC-Based ACL
Gonfigure Port Setings Create IP-Based ACL

Configure QoS
Device Status
» Access Control
» Quality of Service.

System Summary

|| English M Display Mode: ERETIIRG locout SNA  About  Hel
o I
Chdvanced >

©2011-2018 Cisco Systems, Inc. All Rights Reserved.

9. Select VLAN Management from the menu on the left side of the screen. The VLAN Management menu will
expand and the VLAN Settings page will be displayed. If the VLAN Setting page is not displayed, click VLAN
Management > VLAN Setting to display the page.

By Default, VLAN 1 is active. If the network is self-contained, skip to 15. Otherwise, continue with the next step.

10. Click the Add... button. The Add VLAN dialog will be displayed. The purpose of creating a VLAN is to separate
a network into separate logical areas / broadcast domains. In this case, the VLAN is created to isolate AV-over-
IP traffic from normal network traffic.

e - . cisco switchdc6%45 Language Dispay Hode: Logout SHA  About Help
cisco SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch I

Getting Started .
- VLAN Settings
Dashboard

c Wizards VLAN Table

Search [0 VLANID | VLANName Originators | VLAN Interface State  Link Status
» Status and Statistics SNWP Traps

> Default Enabled Enabled
v Port Management

Delete
» Smariport [ Adel VLAN - Google Chrome — a x

- @ Notsecure | 192.168.0.117/csd8f3a7fd/Vmember/bridg_vlan_properties_a.htm
VLAN Settings
Interface Settings
Portto VLAN
Port VLAN Membership # VLAN ID: (Range: 2 - 4094)
» VLAN Translation
Private VLAN Settings VLAN Name: (0/32 characters used;
GVRP Setlings
» VLAN Groups
» Voice VLAN Link Status SNMP Traps: & Enable
» Access Port Multicast TV VLAIE
» Customer Port Multicast TV

@ VLAN

VLAN Interface State ¥ Enable

Range

» Spanning Tree 3 VLAN Range: | - (Range: 2 - 4094)

st [ Ciose |

» WAC Address Tables

» IP Gonfiguration
» Security

» Access Control

> Quality of Senvice
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Network Switch Configuration

11. Enter the numerical ID of the VLAN in the VLAN ID field. This value is required and must be within the range of 2
to 4094.

o NOTE: VLAN 1 is the Cisco default VLAN. This VLAN can be used, but it cannot be modified or
deleted.

12. OPTIONAL: Enter a name for the VLAN in the VLAN Name field. For example, the name of the VLAN could
be used to identify a department, within a company, which uses that broadcast domain. In this example,
“OmniStream” has been assigned as the name of VLAN 5.

[ Add VLAN - Geegle Chrome - O ®
A Mot secure | 192.168.0.117 /csdEf3a7fd/Vmember/bridg_vlan_properties_a.htm

= VLAM
# VLAN ID: 5 | (Range: 2 - 4094)
VLAM Mame: |C}mni5tream | (1032 characters used)

VLAM Interface State: |« Enable
Link Status SNMP Traps: |« Enable
I Range

# VLAN Range: | - (Range: 2 - 4094)

(o [ Gose |

13. Click the Apply button to commit changes. If the VLAN was successfully created, the dialog box will display a
“Success” message.

v Success. To permanently save the configuration, go to the Copy/Save Configuration page or
click the Save icon.

® VLAN
£ VLANM 1D | | (Range: 2 - 4094)
VLAN Mame: | | (0432 characters used)

VLAN Interface State: |« Enable
Link Status SNMP Traps: |« Enable
I Range

# VLAN Range: | - (Range: 2 - 4094)

(o] [ ciose |

OmniStream
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Network Switch Configuration

14. Repeat steps 11 through 13 to create as many VLANs as needed. If no additional VLANs are required, click the

Close button to dismiss the Add VLAN dialog box.

15. Click Administration, in the left-hand menu bar and select File Operations. The File Operations page will be

displayed.

16. Click the Duplicate radio button, next to Operation Type.

cisco SG350X-24MP 24-Port Gigat;i_t PoE Stackable Managed Switch

cisco switchdessss  Language: [ENE]

~ EEEEE Advanced - [EEIEEET

SNA  About Help

Discovery - Bonjour
> Discovery - LLDP.
+ Discovery - GDP
Locate Device
Ping
Traceroute
» Port anagement
» Smartport
» VLAN Management
» Spanning Tree
» WAC Address Tables
v Wulticast
Properties
MAC Group Address
1P Hulticast Group Address
~ IPv4 Multicast Configuratio
IGHMP Snooping
IGHP Interface Settings
IGHMP VLAN Seftings
IGHMP Proxy
+ IPY6 Mutticast Configuratio
IGHPIMLD Snooping IP Mu
Multicast Router Port
Forward All
Unregistered Multicast

+ IP Configuration -

| File Operations

Operation Type: ) Update File
©) Backup File
@® Duplicate
Destination File Type: & Running Configuration
O Startup Configuration
Wirr guration
Log 3
O Language File

Copy Method: @ HTTPHTTPS
O usB

O TP
© SCP (File ransfer via S

& ERIENE Browse... | Nofile select

fesomn[_comn |

O Internal Flash DDETElﬂUFI T}'DEZ

() Update File
() Backup File
(® Duplicate

Destination File Type: (® Running Configuration

"y Startup Configuration
Mirrar Configuration
Logging File

4 anounan Cila

cisco SG350X-24MP 24-Port Gigaé{t PoE Stackable Managed Switch

Geting Started
Dashboard
Configuration Wizards

File Operations

Success.

cisco  switchde6945 Language: ST [ Display hode: Logout SNA Aboul Help

aQ

» Status and Statist

System Settings
Console Setings
Stack Management
User Accounts
Idle Session Timeout
» Time Seftings
> System Log

Operation Type O Update File
O Backup File
@® Duplicate

Source File Name: @ Running Configuration
O Startup Configuration
O Mirror Configuration

Destination File Name: (| Running Confiouration
@ Stariup Configuration

- Fil
Firmware Operations
File
File Directory
DHCP Auto Configuratior
» PNP
Rebaot
Hardware Resources
Discovery - Bonjour
» Discovery -LLDP
» Discovery - CDP
Locate Device
Ping
Traceroute
» Port Management
» Smartport

v VLA Management

o[ cann |

Inc. All Rights Reserved.

OmniStream

11
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Network Switch Configuration

IPv4 Interface Setup

18. Click IP Configuration in the left-hand menu bar and select IPv4 Interface. The IPv4 Interface page will be
displayed.

al - = cisco  switchdesss  Language Dispay Woce: [T Logowt SNA FmaT About Hep

cisco SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch I
Getting Started
Dashboard
Configuration Wizards

IPv4 Interface

| IPv4 Routing Enable

I1Pv4 Interface Table

[ | Interface IP Address Type IP Address Mask Status

[0 vLAN1 DHCP  0.0.0.0 255255255255 Not received
> Spanning Tree [0 viAN1 Default 1921681254 2552552550  Valid

» WAC Address Tables Add. Edit Delste

~ IPvd Management and Interfad
IPv4 Static Routes
IPv4 Forwarding Table
» Access List
ARP
ARP Proxy
UDP RelayP Helper
» DHCP $nooping/Relay
» DHCP Senver
» IPv6 Management and Interfad
+ Policy Based Routing

ms, Inc. All Rights Reserved

19. Click the check box next to VLAN 1 (DHCP) and then click the Delete button.

N — - 2 cisco  switchde6945  Language: [V [ ocpayroce: [INNETIRY logout SNA  Fram  About Hep
cisco SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch I C

Getiing Started

Deshooara IPv4 Interface
Configuration Wizards ‘ e —
> Status and Statistics E
N ;
» Port IPv4 Interface Table
» Smartport [] Interface IP Address Type IP Address Mask Status
> VLAN
» Spanning Tree [] VLAN1 Default 192.168.1.254 2552552550 Valid
» MAC Address Tables Add. Edit Delete

~ IPv4 Management and Interfa
IPu4 Static Routes
IPv4 Forwarding Table
» Access List

e e IPv4 Interface

UDP Relay/IP Helper
» DHCP Snooping/Relay
» DHCP Server

+ IPV6 Management and Interfad

- rlcysons g IPv4 Routing: Enable

[—m—] [ Cancel ]

IPv4 Interface Table
] Interface | IP Address Type @ IP Address Mask Status

] WLAMA Default 192.168.1.254 255.255.255.0 Valid

Edit. | (G Delete-])

ms, Inc. All Rights Resenved
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Network Switch Configuration

20. Check the IP settings for VLAN 1. If no changes are required, continue with Step 4. However, if a different IP
address or subnet mask need to be specified, then follow the steps below:

a. Click the check box next to VLAN 1.

b. Click the Edit button.

feco  switchdeasts Langusge: [T B ospiey oce Logost SNA FnaT Aot Help

ehst’ SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch [

Getting Started

IPv#4 Interface

Success. To permanently save the configuration, go to the Fil= Operations page or click the Save icon

| IPv4 Routing: Enable

[apply| [ cancel

IPv4 Interface Table

> Smariport

Interface | IP Address Type | IP Address

v IPvd Management and Interfad
1Pv4 Static Routes
IPv4 Forwarding Table
» Access List
ARP
ARP Proxy X
Uoe e lr IPvd Routing: Enable
» DHCP Snooping/Relay
» DHCP Server
» IPv6 Management and Interfaq
» Policy Based Routing

EEEEE [—iﬂﬁ—” Cancel ]

IPv4 Interface Table
Interface  IP Address Type @ |IP Address Mask Status

©2011-2018 Cisco Systems, Inc. All Rights Resenved

c. The Edit IP Interface dialog will be displayed.
d. Make make the required changes, then click the Apply button to commit changes.

e. Click the Close button to dismiss the Edit IP Interface dialog box.

Y Edit IP Interface - Mogzilla Firefox

GJ 192.168.1.254//cs7d5elf3e/mts/ipaddr/system_ipcont_ipinterface_e_jg.htm s (V) 'i'.'.? é}

Interface: I WLAM 1 | s

IP Address Type: () Dynamic P Address
(@ StaticIP Address

IP Addreszs: 192.168.1.254
& Mask: @ Network Mask [255.255.255.0
O PrefixLength | Range: & - 30
Renew [P Address MNow: Enable
Auto Configuration via DHCP: Disabled

[hpplyof [ Close |

OmniStream 13




a PaNpuIT company

Network Switch Configuration

21. Click the Add... button. The Add IP Interface dialog box will be displayed.

22. Click the VLAN radio button, then click the drop-down list to select the VLAN that was created under VLAN
Setup (page 9).

23. Click the Static IP Address radio button.

o NOTE: It is recommended that a static IP address be assigned to a VLAN, to avoid IP changes.

24. Enter the IP address of the VLAN, in the IP Address field. In the example below, 10.1.1.254 is used. However,
any available IP address in the pool may be used.

25. Click the Network Mask radio button and enter the subnet mask. In this example, 255.255.254.0 is used.
However, depending upon the requirements, any valid network mask may be used.

TR - cisco  Switchde6945  Language: Display Node: Logost SNA FndT Apout Help
alialn
cisco  SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch I
Getling Started
IPv4 Interface
Dashboard
s guoliopilizagic ‘ 1Pv4 Routing Enable ‘
Search
» Stalus and Stalistics [ ———
5
+ Port IPv4 Interface Table
» Smaripart [ Interface IP Address Type  IP Address Mask Status
» VLAN [] VLANA Static  192.168.1.254 2552552550 \Valid
» Spanning Tree Add.. Edit Delete
* WAG Address Tables ) Add IP Interface - Mozilla Firefox
> Mulicast %
C @ 192,168.1.254/cs7d5e0f3e/mis/ipaddr/system_ipeont ipinterface_a_jg.htm -y =
~ IPv4 Management and Interfa
z
Inter unit [7777 port [2ET Lac 3 vLAn [515] O Leopback
= - nterface: O Uni 0 o ® O Leopbaci
IPv4 Forwarding Table IP Address Type: (O Dynamic IP Address
» Access List @ Static IP Address
ﬁ # |P Address: 10.1.1.254
UDP Relay/IP Helper & Mask @ Network Mask |§552552540
+ DHCP Snooping/Relay li nae 8- 3
Range: 8- 30
. g © PrefixLength ang:
» IPv6 Management and Interfag
- P sasamog -
» DNS

> Security
» Access Control

— Interface: ) Unit |1— Port IT O LAG |1_ ® VLAN IE’ v O Loog

IP Address Type: () Dynamic P Address

- — (@) Static IP Address
2 |P Address: [10.1.1.254
# Mask: @ MNetwork Mask [255.256.254.0
i) Prefix Length | (Range: & - 30)

26. Click the Apply button to commit changes. Repeat Steps 4 through 9 for each additional VLAN, as necessary.
27. After all VLANs have been set up, click the Close button to dismiss the Add IP Interface dialog box.

28. Click Administration > File Operations in the menu bar on the left side of the screen. The File Operations
page will be displayed.

29. Click the Duplicate radio button, next to Operation Type. Refer to the next page for more information.

OmniStream 14
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Network Switch Configuration

cisco  switchde6%45  Language: [T Display Mode: [FNNTIRIRY locout SNA About Help

cisco. SG350X-24MP 24-Port Gigat;i_t PoE Stackable Managed Switch

Discovery - Bonjour
> Discovery - LLDP.

File Operations

> .
E"Sc‘:"e: &2 Operation Type: @ Update File
p"me evice. ©) Backup File
ng O Duplicate
Traceroute
——— Destination File Type: (&) Running Configuration
O Startup Configuration
S0 s— Wirror Configuration
» VLAN Management Logging Fil
» Spanning Tree O Language File
» WAC Address Tables Copy Method. @ HTTPHTTPS = .
AT — & o = File Operations
Properties O Intemnal Flash
MAC Group Address Q TFTP
P Wulticast Group Addrese O SCP (File transfer via SSH)
~ IPv4 Muficast Configuratio % File Name Browse... | Nofle selected . i
6P Snacaing Operation Type: () Update File

IGHP Interface Settings
CHPVLAN Setings & |-apply-| [ Cancel ] Backup Fil
e O p File

+ IPY6 Mutticast Configuratio »
IGMP/MLD Snooping IP Mu (o D U p. |Ca‘te
Multicast Router Port
Forward All
Unregistered Multicast

Frr— Source File Name: (® Running Configuration
- - () Startup Configuration
() Mirror Configuration

Destination File Mame: Running Configuration
(® Startup Configuration

[—‘\HU—H Cancel ]

30. Click the Apply button to commit changes.

ahan - cisco  switchdess45  Language Dispiay Hods: Logout SHA  About Holp
cisco SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch I

Geting Started
Dashbeard

Configuration Wizards
Success.

» Status and Statist

File Operations

Operation Type: () Update File
System Settings O Backup File
Console Setings (@ Duplicate
Stack Management Source File Name @ Running Configuration
User Accounts () Startup Configuration
Idle Session Timeaut O Miror Configuration
Time Settings
System Log
Fil

Firmware Operations

Destination File Name: | yning Confiouration
@ Startup Configuration

= |

File Directory
DHCP Auto Configuratior
PNP
Reboot
Hartware Resources
TEEEy = B log Natification (Notice)
Discovery - LLDP. "Y-N-TRAP: The Copy operation was
Discovery - CDP completed successfully
Locate Device
Ping
Traceroute
» PortManagement Syslog Nofification (information)
» Smariport 9%COPY--FILECPY: Files Copy
running-config destination URL
v VLA Wanagement Iconfiguration/startup-confia

5. Inc. All Rights

OmniStream
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Network Switch Configuration

Configuring IP Multicast

31. Click Port to VLAN from the VLAN Management menu. By default, the Membership Type, for each physical
port (interface), is assigned as Untagged.

cisco  switchde8945 Language: [EITE [ Disploy bode: Logout SNA Find About Help
~

'::Illslélc;l SG350X-24MP 24-Port Gigalﬂft PoE Stackable Managed Switch

Getting Stated ~
Port to VLAN
Dashboard
c Wizards L ip Table Showing 1-28 of 28 | All . per page
Filler VLANID equalsto [ 1]
AND Interface Type equals to | Portof Unit 1|
Interface Name | VLAN bode | Membership Type | PVID
cE1 Access Untagged |~
GE2 Access Untagged |
GE3 Access Untagged |
Interface Settings GE4 Access Untagged  |v
Portto VLAN | —
e ‘Membership GE5 Access Untagged v
b VTS T GES Access Untagged |
Private VLAN Setings GET Access Untagged v
GVRP Seftings GE8 Access Untagged v
F IAAEETD GEY Access Unfagged  |v
» Voice VLAN Tl ke
b e P T ] GE10 Access Untagged |
» Customer Port Multicast Ty GE™ Access Untagged v
T GE12 Access Untagged v
+ MAG Address Tables GE13 Access Untagged v
GE4 Access Untagged |
o ces Access Untagged v
Access Untagged v

32. Click the VLAN ID equals to drop-down list and select the VLAN ID that was created under VLAN Setup (page
9).

33. Leave the AND Interface Type equals to drop-down list as Port of Unit 1. Click the Go button.

iah cisco  switchde6945 Language: [EINIE) 4 Dispiay Mode: PUCUICIIER] Logout SNA FindT About Help
afaln

cisco SG350X-24MP 24-Port Gigabﬁ _PoE Stackable Managed Switch

Getling Started ~ bl
————— | Portto VLAN

Dashboard

C Wizards Vi ip Table Showing 1-28 028 | Al . per page
| Search || Firer vian D equalsto

» Status and Statistics

|* SlsusandStststies 1
= i AND mrerfacsTypsm PortofUnit1 +

> Port Interface Name | VLAN UICSS®embership Type | PVID

» Smartport GE1 Access Untagged |+

|+ VLANManagement | GE2 Access [Untagged |+
VLAN Settings GE3 Access [Untagged | Purt tD VLAN
iz dEiy GE4 Access [Untagged |~
ces r eErErr—

VLAN Membership Table

Filter VLAN /D equals to

AND Interface Type_L__|to |PortofUnit1 v | Go

Interface Mame = VLAM M embership Type @ PVID
GE1 Access | Untagged |«
GE2 Access | Untagged |«
GE3 Access | Untagged |«
Access | Untagged
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34. The Membership Type, for the VLAN, will automatically be assigned as Excluded for each physical port on the
switch.

cisco  switchde6945  Language: [ERela] [ Display ode: XSSl Looout SNA FindT  About Help

I

cisco SG350X-24MP 24-Port GigaBﬁ PoE Stackable Managed Switch

Getting Started A Port to VLAN

Dashboard
c Wizards v ip Table Showing 1-28 of 28 | All |~ | per page
iaary Filler VLAN D equalsto | 5[]

> Stalus and Stalistics

N AND Interface Type equals to | Port of Unit 1 |v|

» Port Interface Name | VLAN hode | Membership Type | PVID

» Smarport GE1 Access Excuded |

GE2 Access |Excluded ||

VLAN Settings CE3 Access [Excluded ||
e SELe GE4 Access [Excuded v
PortVLAN Wembership 58 eSS [Exciuced ]

o T T T GES Access Excuded |-
Private VLAN Settings GET Access Excuded |
GURP Seftings GEB Access |Excluded ||

b TAGIERTD GEY Access Excluded |-
» Voice VLAN =
) el EOR—— GE10 Access Excuded
+ Customer Port MuticastTh ., | | GE11 Access Excuded v
Access Excuded v

stems, Inc. All Rights Reserved

35. Determine which physical ports will use the selected VLAN. Click the Membership Type drop-down list for each
physical port that will use the VLAN, and set its value to Untagged. For example, if physical ports 6 and 7 will be
used for VLAN 5, then set the Membership Type for these two ports to Untagged.

Port to VLAN

VLAN Membership Table

Filter VLAN /D equals to IE o

AMD Interface Type equals to |F'nrt af Lnit 1 |~ Go

Interface Mame = VLAMN Mode  Membership Type | PVID
GE1 Access | Excluded
GE2 Access
GE3 Access
GE4 Access Mulkicast TV VLAN
GES Access | Excluded v

36. Scroll to the bottom of the list of ports and click the Apply button. Success messages will appear at the top and
bottom right of the screen.

NOTE: If the port the PC is connect to is move off VLAN1, then it will need to be set to the IP settings of the
new VLAN to continue.

=
Ineriace Setings GE1 Access Excuded |
Portto VLAN GE2 Access Excuded |~
Port VLAN Membership GE3 Access Excluded |~
F Gkl e GE4 Access Untagged v
Private VLAN Setlings ——
e e GES Access Untagged v
» VLAN Groups GES Access Untagged -
» Voice VLAN GE7 Access Untagged |
F AEERRR P (Rt GES Aocess Untagged |
> oo &
Customer Port Multicast T\ oeo ccess T
b s T —
DM Syl GE10 Access Untagged |
» MAC Address Tables
GET1 Access Excuded |-
GET2 Access Excuded |~
~_IP Configuration
GE13 Access Excuded |
~ IPvd Managementand Inte e
A GE14 Access Excuded v
[Pvé StaticRoutes GE1S Access xcluded 1 Notification (Notice):
IPv4 Forwarding Table GE16 Access Excuded |- opy operation was
b el GETT Access Excluded |~
y GE18 A Excluded
i coess Jcluded |
UDP RelaylP Helper GE19 Access Untagged |~
» DHCP Snooping/Relay GE20 Access Excuded v
» DHCP Server cE24 Access Excuded |
» IPY6 Management and nte —_—
» PolicyBasedRoutng v | | °522 Access Excluded v Iconfiguration/startup-config
Access Excuded |~
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37. Click Multicast from the menu bar on the left side of the screen. The Properties window will automatically be
displayed.

cisco  swilchde6945  Language: SN [ Oisplay Mode: PNNINEIRd Locout SNA About Help

Q

'Z'.'s'é'&' SG350X-24MP 24-Port Gi'ga-l;it PoE Stackable Managed Switch

Discovery - Bonjour
» Discovery-LLDP
» Discovery- CDP
Locate Device
Ping
Traceroute VLANID [T~
» PortManagement

" | Properties

Bridge Multicast Filtering Status: [ ] Enable

Forwarding Method for IPv6: & MAC Group Address

O IP Group Address

© Source SpecificIP Group Address
Forwarding Method for IPvd: (8 MAC Group Address

O IP Group Address

© Source Specific IP Group Address

HAC Group Address Ernn |

IP Multicast Group Addrese v

38. Click the Enable box, next to Bridge Multicast Filtering Status, to enable this feature.

39. Click the IP Group Address radio button, under both Forwarding Method for IPv6 and Forwarding Method for
IPv4.

Properties

Bridge Multicast Filtering Status: Enable

WLAM ID: I‘I e

Forwarding Method for IPvE: ) MA o Address
(@) |IP Group Address
() Source Specific IP Group Address

) MAC p Address
(@) IP Group Address
() Source Specific IP Group Address

Forwarding Method for 1Pv4:

[—m—] [ Cancel ]

40. Click the Apply button to commit changes.

41. Repeat steps 38 and 39 for each VLAN.

42. Click IGMP Snooping, under IPv4 Multicast Configuration, from the menu bar on the left side of the screen.

—— T -

» Smartport [—.A.p.pw—][ Cancel ][ IGMP Snooping IP Multicast Group ]

F WLAM Management

¥ 3Spanning Tree IGMP Snooping Table

» MAC Address Tables Entry Mo. | VLAMID | IGMP Snooping Status MRouter Ports | Immediate | Last Membs

Administrative | Operational Auto Learn Leave Cluery Counte
Properties J 1 1 Disabled Disabled Enabled Disabled
MAC Group Address o -
IP Multicast Group Address R RS B
* |Pvd Multicast Configuratio
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43. Click the check box next to IGMP Snooping, to enable this feature.

44. Click the Apply button to commit changes.

IGMP Snooping

IGMP Snooping is only operational when Eridge Multicast Filiering is enabled. Bridge Multicast Filtering is currently enal

IGMP Snooping Status: Enable
IGMP Querier Status: Enable

Apply ][ Cancel ][IGMF’SnoopinglF’I'u'IuIticastGroup

45. Click the radio button next to VLAN 1, as shown below, in the IGMP Snooping Table.

cisco  switchde6345 Language: BN Display Mode: [ERNETISTIRG Logout

SNA  About Help

Q

cisco SG350X-24MP 24-Port Gigat;it PoE Stackable Managed Switch

Discovery - Bonjour “1 icmP Snooping
+ Discovery-LLDP
» Discovery - CDP =
Locate Device Success. To permanently save the configuration, go to the File Operations page or click the Save icon.
Ping
Traceroute IGNMP Snooping is only operational when Eridge Huliicas! Fillering is enabled. Bridge Multicast Filtering is currently enabled.
» Port
» Smartport IGMP Snooping Status: [] Enable
» VLAN Management IGMP Querier Status: Enable
» Spanning Tree
» MAC Address Tables |~~pply—|| cancel || IGHP Snooping IP Multicast Group
PropT IGHP Snooping Table
MAC Group Address: EntryNo. | VLANID | IGMP Snooping Status WRouter Ports | Immediate | LastMember IGMP Querier Status IGMP Querier | IGMP Querier | Querier
IP Multicast Group Address Operational Auto Lean Leave | Query Counter Operational | Election Version 1P Address
~ IPv4 Multicast Configuratio
e
IGMP Interface Setiings v Copy Settings. Edit.
< > —

46. Click the Edit... button to display the Edit IGMP Snooping Settings dialog box.

Y Edit IGMP Snooping Settings - Mozilla Firefox

@ 192.168.1.254/csafab2 1cd/multicast/igmp_snooping_e_jg.htm e I f? é}
VLAM ID: I'I w
IGMP Snooping Status: [J] Enanle

MRouter Ports Auto Learn: Enable

Immediate Leave: [] Enable
# Last Member Query Counter: @ Use Query Robustness (2)
() UserDefined | Range: 1-7

IGMP Querier Status: [] Enable

IGMP Qluerier Election: Enable

IGMP Querier Version: V2

Querier Source IP Address: Auto

User Defined

\hpply—|| Close

OmniStream
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47. Click the Enable checkboxes next to IGMP Snooping Status, Immediate Leave, and IGMP Querier Status.
Make sure each of these checkboxes display a checkmark. Leave the rest of the settings as they are.

48. Click the Apply button to commit changes.

Y Edit IGMP Snooping Settings - Mozilla Firefox

(0] 192.168.1.254 /csafab2 1cd/multicast/igmp_snooping_e_jq.htm e (W) T:f
VLAM 1D: |1 v
IGMF Snooping Status: Enable

MRouter Ports Auto Learn: Enable
Immediate Leave: Enable

# LastMember Query Counter: @) Use Query Robustness (2)

() User Defined | Range: 1-7
IGMP Querier Status: Enable
IGMP Querier Election: Enable
IGMP Querier \Version: @ v2

v3

Querier Source |P Address: @ Auto
() User Defined

192.168.1.254

tpplyf | Close |

49. Click the VLAN ID drop-down list, and select the next VLAN ID number. Repeat steps 17 and 18 for each VLAN
that was created.

50. Click the Close button to dismiss the Edit IGMP Snooping Settings dialog.

51. Click Administration > File Operations in the menu bar on the left side of the screen. The File Operations
page will be displayed.

52. Click the Duplicate radio button, next to Operation Type, then click the Apply button to commit changes.

cisco  switchde6945  Language: [Eipee) [ oipiay ode: PRV locout SMA  About Help

"tistl’ SG350X-24MP 24-Port Gigabit PoE Stackable Manag

\ s Sae | Fie Operations File Operations
" E":;U:E:m?gp Operation Type: @ Update File
Backup File
::l:gelmlle 8 DuDthte . )
— Destination File Type: (@ Running Configuration DpEratIUrl TFDE: l:::l Upda‘te File
T () Startup Configuration )
—] el ") Backup File
» Spanning Tree. O Language File @ Duplicate
- ::E;‘:"“SS b Gopy Method: 8 DSWBPMWPS —
operties (O Intemal Flash . . ) i
e O e Source File Mame: (® Running Configuration
IP Wulticast Group Address () SCP (File transfer via SSH) -
« oy | Fitins e ET TR () Startup Configuration
e — oo i) Mirror Configuration
IGMP Proxy
i Destination File Name: Running Configuration
Multicast Router Port
B — (® Startup Configuration
~_IP Configuration o

c. All Rights Reseved

[—#ﬂ—] [ Zancel ]

OmniStream 20




/N\T LOMN/.

a PaNpuIT company

Network Switch Configuration

583. Click Unregistered Multicast from the Multicast menu on the left side of the screen. By default, all physical
ports will have port forwarding enabled, as shown below.

alaln
cisco

SG350X-24MP 24-Port Giga-t;ﬁ PoE Stackable Managed Switch

cisco  switchde8945  Language: [EIT [ Display Mode: Logout SNA About Help

Getting Started . .
Unregistered Multicast
Dashboard
Configurafion Wizards
Search Filter: Interface Type equalsto | Port of Unit 1w

» Status and Statistics

» Administration

» Port Management

» Smartport

» VLAN Management

» Spanning Tree

» MAC Address Tables

Port GE1 GE2 GE3 GE4 GE5 GEG GE7 GES GE9 GE10 GETl GE12 GE13 GE14 GE15 GE16 GE17 GE13 GE19 GE20 GE21 GE22 GE23 GE24
Fowading @ ©®© © @ ©® ©®© @ ©®@ ® @ @ ® ©® @ @ ® ® ® ©@ ©® ® ® ® ®
Felng O O O © O O O 0 O O © O O O ©C O O O © O O O O O

Port XG1 XG2 XG3 XG4

Forwardng ® @® @® @
Filtering o O O O

Froperties
MAG Group Address
1P Multicast Group Address
~ IPud Wulticast Configuration
IGMP Snooping
IGMP Interface Settings
IGMP VLAN Setiings
IGMP Proxy
» IPV6 Mutticast Configuration
IGMPIMLD Snaoping IP Multic]
Multicast Router Port

oo |

54. Click the Filtering radio button to assign port filtering to each port.

55. Click the Apply button to commit changes.

Unregistered Multicast

Port GE1

Filtering

Port HG1

Filtering

GE2 GE3 GE4 GE5 GE6

Fowadng O O O O O O O O O O O O O O O O O O O O O O O O
®© ©® ® @ ® @ ©@ ©®© © ® @ @®@ © @ O @ © @ ©@ ©®© @®@ @®@ @ @

Filter. Interface Type equals to IF'ortofUniH ~

GE7 GE&8 GE9 GE10 GE11 GE12 GE13 GE14 GE15 GE16 GE17 GE18 GE19 GE20 GE21 GE22 GE23 GE24

XG2 XG3 XG4
Forwarding O O O O
®©® ® ® @®

[—&pﬂy—] [ Cancel ]

56. Click Administration > File Operations in the menu bar on the left side of the screen. The File Operations
page will be displayed.

57. Click the Duplicate radio button, next to Operation Type, then click the Apply button to commit changes.

i
CIsco

Getling Started
Dashoeard
Configuration Wizards

» Status and Statisti

SG350X-24MP 24-Port Giga-l;ijf PoE Stackable Managed Switch

cisco  switchde6345  Languace: ST [ Display Mode: Logout SNA About Hep

File Operations

Success.

System Settings
Console Setings
Stack Management
User Accounts
Idle Session Timeout
» Time Settings
» System Log

Operation Type O Update File
O Backup File

@® Duplicate

@® Running Configuration
O Startup Configuration
O Mirror Configuration

Source File Name:

Destination File Name: =00 Confiourato
@ Startup Configuration

- Fil
Firmware Operations
File Directory
'DHCP Auto Configuratior
» PNP
Rebaot
Hardware Resources
Discovery - Bonjour
» Discovery -LLDP
» Discovery - CDP
Locate Device
Ping
Traceroute

» PortManagement

v VLA Management

o[ _ann |

Notification (Nofice).
I-TRAP: The copy operation was
completed suc

Notification (Informatio
Y--FILECPY: Files C
running-config destination URL fi

Iconfiguration/startup-config
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Creating User Accounts

This next section is optional, and provides instructions on creating user accounts. This is only required if multiple
users will need access to the network switch.

1. Click User Accounts from the Administration menu.

cisco  switchde694!
afraafn,

cisco SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch

Getting Started

Dashboard
Configuration Wizards
Search

» Status and Statistics

User Accounts

Password Recovery Senvice: Enable

[ F— ]

i \pply 1 Cancel ]
System Settings User Account Table
Console Settings UserMame = User Level
Stack Management O cisco Read/Write Management Access (15)
User Accounts
di alata
Idle Session Timeout B REE

& Tima Qaltinne

£

@ 2011-2018 Cisco Systems, Inc. All Rights Reserved.

2. Click the Add... button to display the Add User Account dialog box.

3. Enter the desired username and password in the User Name and Password fields, respectively. Confirm the
password by re-entering it in the Confirm Password field.

4. Click the Read/Write Management Access radio button, then click the Apply button to commit changes.
5. Repeat steps 2 through 4, as required, for each user.

6. Click the Close button to dismiss the Add User Account dialog box and click Yes when prompted to save
changes.

Y Add User Account - Mozilla Firefox

GY 2 192.168.1.254/cs7Td5elf3e/mts/password/security_manage_localusers_a.htm - O

The minimum reguirements for password are as follows:

+ Cannot be the same as the user name.

= Minimum length is 8.

* Minimum number of character classes is 3. Character classes are upper case, lower case,
numeric, and special characters.

Mew User
5 User Mame: minion (6/20 characters used)
Password: (17764 characters used)

Confirm Password:

Password Strength Meter: [ T Strono
User Level: Read-Only CLI Access (1)
Re imi i I
o Read/\Write Management Access (15)

hpply|[ Ciose |
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Click Administration > File Operations in the menu bar on the left side of the screen. The File Operations
page will be displayed.

Click the Duplicate radio button, next to Operation Type.

Click the Apply button to commit changes.

. Switch configuration is complete.

cisco  switchde6945  Language: [ST [ Disploy Node: Logout SMA About Help

mmin
cisco

SG350X—24MF; 24-Port Gigabit boE Stackable Managed Switch

Discovery - Bonjour
» Discovery - LLDP
» Discovery - CDP

" | File Operations

: Operation Type @ Updats File
:’dem“'ce O Backup File
" O Duplicate

Traceroute

+ Port anagement
+ Smartport

+ VLAN Management
» Spanning Tree

Destination File Type: @ Running Configuration
O Startup Configuration

Mirr

File Operations

b ricn gy Copy Method: @ HTTPHTTPS
~ Wuticast O uss T -
Properties 8 Internal Flash
MAC Group Address TFTP . ) .
P tcas Group Addrst O 80P (e anstera s5¥) Operation Type: Update File
= IPv4 Multicast Configuratio # File Name: Browse. | No file selected. =
IGHP Snooping . H
[l i =
IGMP VLAN Settings ﬁ Cancel

1GHP Proxy

> IPVE Multicast Configuratio.
IGMP/MLD Snooping IP Mu
Multicast Router Port
Forward All

(® Running Configuration
- ‘Pucr.;';e:::::"mmcasl l:::l Startup Co nﬁgurﬂtiﬂn
[ ) Mirror Configuration

Source File Mame:

ns, Inc. All Rights Resenw

Destination File Mame: Running Configuration

(® Startup Configuration

[—hﬂ—] [ Cancel ]
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AMS must be used for configuration of all the OmniStream devices, but before OmniStream is set up, AMS must be
set up and up to date. The following instructions will walk through all the AMS set up and OmniStream discovery
steps.

Getting an IP Address

AT-AMS-HW
1. Find the IP of the AMS-HW.

a. Using the HDMI port, connect an HDMI cable from the HDMI OUT port to an HDMI IN port on the local
display. The unit IP will display at the bottom right hand corner of the display.

b. If If there is no local display, open the connected PC and do an IP scan using any IP scan program.
AT-AMS-SW

Follow the installation steps found within the AMS-SW download file. The IP address will be displayed in the Virtual
Machine window.

Login

Once AMS has been set up and the IP address located, it can be used to configure the OmniStream devices. Use the
following steps for the initial login of AMS.

1. Open any browser and type the IP address in, as shown below.

2 Products < Atlona® AVE X ¥ () Atlona Velocity | Dashbe X

& C | ® Notsecure | 192.168 X XXX *| 0

2. Enter the login information on the AMS web page, then click the Login button. Note that the password is
masked when typed.

Login: admin NTLOMNA. NOTE: Once the initial log in and
Password: admin a PanpuiT company activation is complete, the new
password should be kept somewhere
easy to find. If the password is lost,
use the steps found within the AMS
manual to reset it.

N\MS

AMS Login

Email Address

Password

Fargot passwaord?

Fill in the initial set up information, including: Company Name, current admin’s First & Last name, the admin’s email
address, and a new password.

NOTE: Passwords must be at least 8 characters and include: 1 number, 1 uppercase letter, 1 lowercase
letter, and 1 special character. The text will appear all green when the password meets all criteria.
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* New 'admin’ password Password criteria

----- | 8 Characters

1 Integer
* Confirmation Password Lowercase
1 Uppercase

1 Special Character

’asswords do not match

Initialize AMS: Account setup Password criteria:

Basic Info Login Info Gateway Info 8 Characters
*Company Name * Primary admin email v 1 Integer
. * Confirmation Password Lowercase
* Primary admin first name. * New ‘admin’ password
1 Uppercase

* Primary admin last name * Confirmation Password

1 Special Character

“asswords do not match.

* New "admin’ password Password criteria
""""" 8 Characters
1 Integer

* Confirmation Password 9

......... 1 Lowercase

1 Uppercase

1 Special Character

Passwords Match!

4. Press SUBMIT once all information is filled.

Updating
Before discovery, it is best to ensure that AMS is on the most recent firmware.

If the PC or AMS are connected to a network with internet connectivity, AMS will automatically check for updates
and give an update notification in the top right corner of the screen if behind. Select the icon and it will go directly to
the Firmware tab inside the System Settings. Follow step 4 of the following update instructions.

If the PC or AMS do not have internet connectivity, the firmware can be checked and/or downloaded at https://
atlona.com/product/at-ams-sw/ under the Firmware tab. AMS’s firmware version can be found at the bottom of the
main screen. If a manual update is needed, go to the firmware section within Server Settings.

1. Locate the user icon in the top right corner of the home page and left click to select.

@/\TLDN/\.

= Lorge Conference = View AMS Documentation AMS Version Notes
i i B ot 2 Profile

= ATANC-108D q Bug Fix: Fixing assword and ip cor d issues h O Shutd Machin

+ installation Guides . AMS Version Notes 2 Users

= Manual A e

(View Ful Notes

+ aroANI20
+ AToANSD A T
o AT A

8 Logout

@ Shutdown Machine

2. Select Server Settings from the drop down menu. A new page will open.
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3. Select Firmware from the top navigation inside of the Server Settings.
o S /¥ = < > &
SETTINGS DATABASE TOOLS EMAIL SECURITY NETWORKS FIRMWARE,

Firmware Update  Current Version: 0.0.94

Drag and drop files here or click to browse for files

pre—

4. Left click on the field to browse the local computer for the firmware file, or drag and drop the firmware into the
field.

“ ® or
NETWORKS FIRMWARE ATABASE Licenses ooLs s FIRMWARE

NOTE: AMS update files will be tar.gz file extensions.
These are compressed files and should not be
extracted before upload.

NOTE: When downloading the firmware file on a
MAGC, ensure that the file is not being auto-extracted.
The option to turn off auto-extraction will be found
within the browser settings.

Firmware upgrading will start automatically.

o S| or (<] > B

SETTINGS DATABASE LICENSES EMAIL SECURITY NETWORKS FIRMWARE

Firmware Update  Current Version: 0.4.5

Drag and drop your files here or pick them from your
computer

Velocity-0.5.3.tar.gz, application/gzip 1.7e+2 Mb

T — )

When the firmware upgrade is successfully completed, a pop up window will appear. It will close a few seconds later
and will redirect the page to Settings.
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Discovery

Once, AMS is fully updated, all OmniStream devices can be found through the device list or rooms page. These
instructions will provide steps for device list discovery.

1. Select the = button from the top left corner. A navigation window will slide open.

2. Select Devices. A new window will appear.

m Bl Device List
Unassigned v
Status ~ Title Model 1P Address MAC Address Version
@ atomni-112:00221
@ atomni-112:00
§ at-omni-112:00221 ATOMNI-112 0204016 BE9BBO019022 25
@ atomni12
@ stomni112:00411 ATOMNITIZ 0204026 BESBBO0TACT0 25
§ stomni112:00502
%5 Dashboard
@ stomni121.00500 § at-omni-112:00437 ATOMNI-112 0204018 BE0BBO0TAQDE 25
<2 Users @ atomni121-00789 § at-omni112:00502 ATOMNITIZ 0204025 BEOBBO0TAZEL 25
@ atomni-121-00872 )
at-omni-121-00500 ATOMNI-121 0204024 BEOBBOOTAGOS 25
@ Sites >
@ atomni122-00446
§ at-omni121-00789 ATOMNII21 0204030 BEOBBO0181:20 25
¥ Devices @ atomni-122:00508
@ stomni12200548 § atomni121-00872 ATOMNI121 0204015 BEOBBO01BICE 25
B Virtual Matrix
@ atomni-512-0003; ") at-omni-122.00446 ATOMNI122 0204027 BB9BBO019252 25
§ atomni512:00048
§ at-omni122:00508 ATOMNI122 0204029 BEOBBOOTATAS 25
§ atomni 512000
"] at-omni-122-00548 ATOMNI122 0204013 BBIBBOOTAGT3 25
@ atomnisi2
§ =0 § at-omni-512-00037 ATOMNI-512 0204019 BEOBBOOTBIFA 25
@ atomni-521-00016 HI Atlona Customer Support Live Ghat (5AM PST - 5P PST) B

OmniStream devices are located through mDNS autoscan and should automatically be discovered and placed under
the unassigned list, but if a device isn’t listed (or using the AT-OMNI-311 and AT-OMNI-324), use the network scan to
find it.

1. Select the SCAN button or press the : icon next to the SCAN button. A new pop up will appear.

a. If:is selected, choose Scan from the drop down menu.

®
i Scan Network
MAC Address Device List Settings o
Qe ] Available Networks
Credentials Mass Update
BE98B001:9022 pelect Networic Scan Network
Firmware %]
Scan HTTPS ports
BEEBO0TATI0
Delete All Devices [ 262 SNEning S
e Select Network
BE9E:B001:A0D6 :
Export Al p 4 Custom Range

eth0:10.20.40.2/24

B 10.20.40.0/24
B 10.20.40.200 - 10.20.40.255
.
@ 192.168.100.1-192.168.200.255
B 10.2050.0/24
B 192.168.100.1-192.168.200.1

2. Select Custom Range (a new screen will take over) or the auto detected network ethO.
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a. If the auto detected network ethQ is selected, press Scan Network to start the scan.

b. If Custom Range is selected, select between IP Range and Subnet Scan

Scan Network Custom Network Scan

Available Networks

eth0: 192.168.11.229/24

® 1P Range
QO subnet Scan
Start IP End IP %]
CLOSE cmca

1. Type in the network range or subnet information.

NOTE: It is recommended to keep the network range scan to under a 512 IP range. The larger the network
range, the longer the scan will take. On subnet scan, AMS will automatically limit the scan to 512 on subnet

23 or 256 on subnet 24.

Custom Network Scan Custom Network Scan

@® PRange QO IPRange

(O Subret Scan @® Subnet Scan

Start IP End IP *IP Address Subnet

192.168.11 192.168.11.254 1921681 92 11.2 B 192.168.11.229 124 192.168 2) B

2. Press the save icon next to IP field. A green CustomNetwork Saved Successfully message will appear at

the bottom of the page when the custom scan settings are saved. o0

3. Press the Submit button to start the scan. The pop up will close when the scan is completed.

Scan Network

Availzble Networks

Custom Range

CLOSE
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Updating Device Firmware

Once all devices are discovered, ensure they are the correct firmware. When AMS or the PC connected to AMS is
connected to the internet, it will automatically display if an update is needed under the update list or the firmware tab
can be checked on https://atlona.com for each individual device.

1. Select the : icon within the device list (circled below) or next to the scan button and select Firmware Update from
the drop down menu. A new pop up will appear.

m Bl Device List
Unassigned Scan @
Status ~ Title Model 1P Address MAC Address Version
@ atomni 11200221
Device List Settings el
@ atomni 11200411
“ atomni-112:00221 AT-OMNIFT12 0.20.40.76 BE:98:B0:01:90:22 25
§ atomni112:0043; H Credentials Mass Update @
“ atomni-112:00411 AT-OMNIT12 0204026 B898:BO.0TA00 25
@ atomni112:00502 H ]
§ atomni121:00500 ( Y “ atomni 112:00437 AT-OMNIT12 0204018 BE08:BO.0TACDE 25
. { a0y An 9 Delete All Devices I}
§ atomni121-00789 ] 10204025 I_D ATOMNIT12 10204025 BIOBBO01AZE4 125 u
@ atomni121:00872 Export All hd
ATOMNI21 0204024 BEBE00TAGOR 25
@ stomizo0ie 3| Reconnect Q —
ATOMNIT21 020.40.30 BEBB00TE120
@ stomni122.00508 H Re-syne Firmware Update
e e ATOMNI21 0204015 BEBR00TEICE
§ atomni122.00548 Device Type
View Logs g AT-OMNI-112
@ atomni512:0003 E ) ATOMNI22 020.40.27 BE9B:B001:9252
¥ v Select Devices 10.20.40.25
at-omni-512-00048
Mave Device AT-OMNI122 0204029 BEBB00TATA6 Select All
§ atomnis12.00050 § at-omni-112-00502 | 10.20.40.25 | Fw. 1.2.5
Uptodate {§
— ATOMNI22 0204013 BEBR00TAGT3 g
@ atomnis Delete Device []
Select Latest Firmware
@ atomni£21.00012 f AT-OMNI 512 0204019 BE9BB00TRIFA 5
omni-521-00012 H 125 Latest Version  ©
§ atomnis21-00016 i (Lrmware Update er Support Live Chat (5AM PST - 5PM PST) B
at-omni-1x2-upgrd-0s-1.2.4.vpup2 «
at-omni-dual-upgrd-os-1.2.3 .vpup2 «
or8

2. Drag and drop the firmware from the local PC or select the yellow box to browse the local computer. Once the
firmware file has been uploaded, it will appear under the Select Firmware section of the dialog box.

3. Select the firmware file name, so that it is highlighted grey.

4. Select UPDATE FIRMWARE button to begin the update process, at the bottom of the dialog box.

Firmware Update

5. Select YES on the confirmation pop up window.

ATOVNITI2
Select Devices 10204025
Select All
at-omni-112-0050210.20.40.25 | Fw. 1.2.5 [
Firmware Update

Select Latest Firmuare
125 Ple onthis Cevice

Latest Version  ©

)

at-omni-1x2-upgrd-o0s-1.2.4.vpup2 M —
at-omni-dual-upgrd-0s-1.2.3 vpup2 M

—
)

After the YES button is clicked, the Upgrade Firmware Started message box will be displayed at the bottom of the
page.

Firmware Update

Firmware Name: “at-omni-dual-upgrd-os-1.2.1_RCO2.vpup2" X

AT-OMNI-112-192.168.11.116:80

Upgrade Firmware Started

The progress bar for the update process will be displayed. The update process should take a few seconds. When
done, press the close button and then refresh the browser page. The update is complete.
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Configuring OmniStream Devices

Once all devices are up to date, they can be configured.

DEVICELIST E i i
- Device List ScAN
Unassigned v g
Status ~ Title Model 1P Adcress MAC Address Version
@ a0
@ a0
@ comninzoos: ATOMNITT2 0204016 BE9BBU010022 25
@ ato
§  aominow TOMNI 0
@ ato
(e " @ cominos AFOMNI2 0204018 289880012006 25
@ ato 8 "] omni 50, ATOMNI112 0204025 BE9BBO01A2ES
@ a0
("} omni 12100500 ATOMNI121 02040. BE9BBOOTAGOS 25
@ a0
'] ATOMNIT21 0 BE9EB001B1:20
§ ato
e ®  comuoen ArowMN121 040 sesea00rE1Co 25
@ ato "] tomni122.00445 ATOMNI122 020402 889880019252
§ oo
[} ATOMNI122 0204029 BEBBODTATE 25
§ ato
[ ATOMNI 122 0204013 B898B001A6T3
§ ato
@ ("] omn512-0003; ATOMNIS12 0204019 BE9BBO01EF4 25
LES " pmpsT) B

If labeling devices, the IP address can be found on the device list, next to the MAC address. If the MAC address was
not noted, the IDENTIFY button can be used within the interface discussed in this section.

1. Select an encoder (AT-OMNI-11X), either from the Unassigned list or the name link in the device list. This will open
the encoder’s interface to the Info tab.

DEVICE INFO SERIAL SESSION ALARMS NETWORK CONFIGURATION

@ AromEST3I.

Device Info
@ Atomestan :
E Alias:

@ atomni111-00355
Model ATOMNI112
@ atomni112:00001 ©
P Address 10204016
@ stomni112:00411

MAC Address BEOBE001:00:22

@ atomni 1120043 : Firmware Version: 125

@ stomnitiz00502 T EAE L DT E

@ atomni121-00500
Description:

@ atomni121-00789

Location:
@ atomni121-00872 E Uptime: 10days, 171 hours, 25 minutes
@ atomni122-00446

Hostname: at-omni-112-00221

@ atomni

O Resetusers O Reset network

=2
@ atomni512-0003.

@ atomni512.0004 : SHOW ADVANCED ~
@ atomni-512-00050 H [ IS

Customer Support Live Chat (5AM PST - 5PM psT) B

@ atomni122-00548

o NOTE: Scroll to the bottom to find the IDENTIFY button, pressing it will blink the front LEDs of the
currently selected OmniStream encoder.

SHOW ADVANCED ~
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Configuring OmniStream Devices

2. Select the Session tab.

DEVICE INFO INPUT SERIAL SESSION ALARMS NETWORK OTHER NFIGURATION
nterface ethl nterface: eth2

SAP: [ ] sAP ®
Scrambling: . Scrambling .

Video Video

Encoder: HDMI Input 1 Encoder HOMI Input 2
Enable Video: . Enable Video: .
Destination 225.0.1.52 Destination 225.0.1.54
Multicast/Unicast Address: Multicast/Unicast Address:

Destination UDP Port 1000 Destination UDP Part 1000

TTL: 255 TTL: 255

Audio Audio

Source: HDMI1 Source: HOMI 2
Enable ACS67: . Enable AES67: .
Downmixing: Downmixing:

Enable Audio: Enable Audio:

3. For the initial configuration to make sure all things are set up to display audio and video to other devices, only the
Destination IP Address and UDP Port fields are required. Scroll down to the Video section first.

4. AMS will automatically assign an IP address and UDP port, notate the Video IP and Port or if preferred, type in a
new multicast IP and Port.

DEVICE INFO INPUT SERIAL SESSION ALARMS NETWORK OTHER CONFIGURATION NOTE: Start With Session
1 and repeat for all the

nterface: ethl nterface: eth2

SAP: ® SAP: ]
Serambling: [} Serambling [}

Video Video

Encoder HDMI Input 1 Encoder HDMI Input 2
Enable Video: o Enable Video: o
Destination 2250.1.52 Destination 225.0.1.54

Multicast/Unicast Address: Multicast/Unicast Address:

Destination UDP Port 1000 Destination UDP Port 1000
Lt 255 L 255
Audio Audio

Source: HDMI1 Source: HDMI 2
Enable AES67 ® Enable AESE7: ®
Downmixing Downmixing

Enable Audio: Enable Audio:

5. OPTIONAL: If the source is HDCP protected, then enable the Scrambling toggle. The toggle will turn green
when enabled. Then, specify the scrambling key in the Key field. Both the encoder and decoder must use the
same key.
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6. Scroll down to the Audio section.

7. Notate the Audio IP and Port or type in a new IP/port. The audio IP and port will differ from the video settings,
this allows audio to be routed independently from the video. It is best to have the Destination UDP Port different
than the video. So if video is 1000, use 1100 for the audio.

255 255 NOTE: Start with Session
1 and repeat for all the
Ao Ao sessions.
Source: HDMI 1 Source: HDMI 2
Enable AESE: . Enable AES67: . .
I s NOTE: In order to work with
- AT-OMNI-238, set the IP
I address to 239.69.X.X and
UDP port 1100.
1100
TTL 255
Control/Serial: Control/Serial:
Not Used Source: Not Used
=]

NOTE: If using AES67 audio routing, be sure to select the Enable AES67 slider so that it is green.
The AES67 audio stream will use the IP and Port from step 3.

| Enable AES67 ® |

8. Repeat this step for Session 2 if using a dual channel encoder.

NOTE: There will be extra sessions listed on the encoders, these are for redundancy. View the
OmniStream manuals to go over redundancy.

_

Name Marme
session3 session4
Interface Interface
Encoder Groups: Encoder Groups:
Group Name Group Name
session3 session4
Enable Encoder Group Enable Encoder Group
Active [ ] Active ®
Trigger Trigger
manual manual
=3 e
Members Members
SAP SAP
Serambling Scrambling
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For Pro Series OmniStream only:

With firmware 1.2.2 or greater, Video Optimization can be used. The Video Optimization option must be the same
on both the encoder and decoder.

DEVICE INFO SERIAL SESSION NETWORK CONFIGURATION
Video Optimization

HDMI Input 1 HDMI Input 2
input Input

HDMI Input 1 HOMI Input 2

Motion Video
t 900 Bit Rat 900
422 ampling 422 h ST w moments to
o ® o
off

off
= =]
NOTE: If connecting a Pro

R OmniStream series to an R-Type
=2 OmniStream, Motion Video must
be selected in Video Optimization.

HIDE ADVANCED  +
HDMI Input 1 HDMI Input 2
Cable Present ° Cable Presen °

9. Repeat steps 1 through 7 for all encoders.

10. Open a decoder (AT-OMNI-12X).

DEVICE INFO IP INPUT HDMI QUTPUT SERIAL ALARMS NETWORK OTHER CONFIGURATION
Alias:
Model: AT-OMNI-122
P Address 10.20.40.29
MAC Address B8:98:B0:01:A1:46
Firmware Version: 125
FIRMWARE UPDATE
Description:
Location:
Uptime: 14 days, 20 hours, 8 minutes
Hostname: at-omni-122-00508
O Reselusers O Resetnetwork

oo [ corr oo

11. Select the IP Input tab.
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1P INPUT SIRAL  ALARMS  NETWORK  OTHR
1P Input 1 (Video 1) 1P Input 2 (Video 2)
Enabled ° Enabled
face et eth2
225004 Multicast Address: 2250078
1000 Por 1000
1P Input 3 (Audio 1) 1P Input 4 (Audio 2)
Enablec ° Enabled °
terface eth Inteface eth2
225005 Multicast Address 22500,
1100
1P Input § (Control 1) 1P Input 6 (Control 2)

12. Set the Multicast Address to match the video Destination IP and Port from the encoder. e.g. Session 1 from the
OmniStream 112.

13. Scroll down to Input 3.

14. Enter the IP and Port from the audio source stream to be routed to HDMI OUT 1. e.g. Session 3 from the
OmniStream 112.

...........

DEVICE INFO 1P INPUT HOMI OUTPUT SERIAL LARMS

1P Input 1 (Video 1) 1P Input 2 (Video 2)

Enabled ° Enabled °

nterface et Inteface eth2
225004 Multicast Address: 2250078
1000 Por 1000

IP Input 3 (Audio 1) IP Input 4 (Audio 2)

Enablec ° Enabled °

terface: eth2
225005 Multicast Addr 2250077
1100 Por 1100

15. Repeat for Session 2 (Video for HDMI OUT 2) and Session 4 (HDMI OUT 2 and analog audio) on the OmniStream
dual channel decoders.

16. Repeat steps 10 through 15 for all decoders.
NOTE: If the OmniStream devices will be used in a video wall, open the HDMI OUTPUT tab and scroll to
the under the Video section and select the slider to enable Video Wall. Select Full Screen from the Stretch/
Crop Mode drop down menu under the Video section. No other settings need to be chosen at this time.
View the Video Walls (page 54) section for configuration.

Video
Vide 1P Input 1 (Video 1)
92 bpc
Off
Backuy 1P Input 7 (Backup Video 1
d 0
Video 1
No active vid
HDR °
Stretch/Crop Mode Keep Aspect Ratio
Resol Auto
1 off
Video Wall
Enable: [ ]
Fast$ [}
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Testing Connectivity

Now that all the OMNIs are set to pass and receive audio and video over IP, basic testing can start.

NOTE: Only one source and display are needed for testing, but multiple can be used, to avoid having to
disconnect and reconnect the HDMI cable from the OMNIs.

1. Connect the HDMI source to the first encoder port.
2. Connect the HDMI Display to the decoder set up to receive that stream.
If all the streams were set up correctly, audio and video will be passed.

3. Repeat steps 1 and 2 for all encoder and decoder ports.

The Audio / Video Settings section can be used to adjust video input and output resolutions and settings for each
stream, for in depth settings, view the OmniStream manuals.
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Controlling the Display using the Display’s IR Remote
The same port that provides RS-232 connections also supports bidirectional IR pass-through, allowing a device to
be controlled from either the headend or the decoder endpoint. This step is optional. IR control is only supported on
RS-232 2 port (bottom set of connectors).

The following sections provide step-by-step instructions for the following topics:

e Controlling the Display using the Display’s IR Remote
e Controlling the Display using a Control System

The illustration below shows a display device being controlled from the encoder. Refer to the next page for details on
how to connect the IR emitter and IR receiver.

Blu-ray Player

P
2,
\i@//;
2

=

&

IR Remote

AT-OMNI-111

IR Signal

_—

Network Switch
Display

AT-OMNI-121
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Required Equipment

Atlona has tested and verified the following components for this application. However, other components may also
be used. Note that IR control is only supported on RS-232 2 port (bottom set of connectors) of the OmniStream
encoder and decoder.

e Xantech 789-44 4-Source Connecting Block
e Xantech 12V PSU

¢ IR Receiver (Atlona AT-IR-CS-RX)

¢ IR Emitter (Atlona AT-OMNI-IR-TX)

Connecting the IR Receiver to the Encoder

1. Unscrew the captive screw connectors on the Xantech 789-44 4-Source Connecting Block, using a regular
screwdriver, and connect the SIGNAL, GROUND, and POWER leads of the AT-IR-CS-RX to the Xantech 789-44
4-Source Connecting Block, as shown below. The presence or absence of white markings on each wire of the
AT-IR-CS-RX will denote the signal type:

IR IN = Dashed dark gray line
GND = Solid (no marking) black wire
+12VDC = solid dark gray line

Xantech 789-44PSRP
4-Source Connecting Block

AT-IR-CS-RX
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2. Connect the IR IN and GND leads, from the 789-44 4-Source Connecting Block, to the to the RX and = pins,
respectively, of the RS-232 2 port (bottom port) of the encoder, as shown.

NOTE: The IR IN, GND, and +12 VDC wires, from Step 1, have been removed from the illustration
below, for purposes of clarity.

Xantech 78944PSRP
4-Source Connecting Block

OmniStream Encoder

3. Connect the Xantech 12 V power supply (or other compatible 12 V DC power supply) to the 12VDC connector on
the Xantech 789-44 4-Source Connecting Block.

Connecting the IR Emitter to the Decoder

1. Connect the included 6-pin Phoenix connector to the RS-232 2 port on the encoder.
2. Connect the SIGNAL wire of the AT-OMNI-IR-TX, to the TX (middle) terminal on the RS-232 2 port.

3. Connect the GROUND wire of the AT-OMNI-IR-TX to the == terminal on the RS-232 2 port.

; AT-OMNI-IR-TX

OmniStream Decoder
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Identifying the Encoder using AMS
1. Launch a web browser and enter the IP address of AMS in the address bar.

2. Enter the required login credentials. The default login is:

Username: admin
Password: Atlona

3. Click the Login button.
4. The AMS Dashboard will be displayed.

5. Click the = icon, in the upper-left corner of the AMS Dashboard.

Welcome

N\MS. .

5 Dashboard

= users ° [ a| =]
-
@ Sites >
Omni Room Edit View AMS Documentation AMS Version Notes
# Devices Building 1 View AMS Documentation) View Full Notes)
B Virtual Matrix Conference Room B Edit = AT-ANC-108D
I
Installation Guidk
Conference Room A Manue!
Edit
Building 1 = AT-GAIN-120

= ATGAIN-60

All Devices

‘Seem To Be Connected

+

Add User

2

Devices Ready To Update

6. Select Devices from the fly-out menu.

7. Click the desired encoder within the AMS Device List window. The AMS interface for the encoder will be
displayed.

DEVICE INFO INPUT SERIAL SESSION ALARMS NETWORK CCONFIGURATION

§ ATOMESTIIA
Device Info
§ ATOMESTIIA
§ atomni1 Alias:
X Model AT-OMNK112
§ atomni-112:00221
P Address 10.20.40.16

§ atomni-112:00411

MAC Address B8:98:80:01:90:22

@ atomni12:00437 : Firmware Version 125

§ atomni112:00502 H FIRMWARE UPDATE

8. Locate and make note of the IP address of the encoder, which can be found in the IP Address field. If using
dual-channel encoders, use the IP address in the IP Address 1 field.
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Configuring the Encoder Serial Port

The first step will be to configure the RS-232 port on the encoder to use IR. Only the RS-232 2 port supports both
RS-232 and IR. Therefore, this port must be used for IR. RS-232 port configuration is managed under the Serial
page of the encoder web interface.

1. Enter the IP address of the encoder in the address bar of the web browser.

2. Enter the required login credentials. The default login is:

Username: admin
Password: Atlona

3. Click the Login button.

4. Click Serial in the top menu bar.

AT IO

<  System information Input EDID Encoding

5. Under Serial Configuration for serial_use2, set the port to Not used.

6. Locate the Serial port configuration window group. The Name field, within this window group, should read
serial_port2. Click the Mode drop-down list and select Infrared.

7. Click the SAVE button to commit changes.

Serial port configuration

serial_port1 Name serial_port2
seria Supported modes infrared, seria
seril + Vioge
9600 infrared
serial
8 -
none
1~ Serial configuration
none = Name serial_uset
Port serial_port1 «
SAVE
Mode Cll
SAVE
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Configuring the Encoder Session

The next step is to assign the IR control for Serial Port 2 to the desired Session.

1. Click SESSION in the top menu bar.

AT LONA

System information Input EDID Encoding Serial

2. Locate the Session 1 window group.

o NOTE: Session 2 can also be used with IR. However, in this example, Session 1 will be configured.

BIE Configuration Users License Upgrade Demo
Name session? Name
Interface ethl - Interface
EncGroup  Enable O EncGroup  Enable
SAP Enable L] SAP Enable
Interval 10 Interval
Name session MName
Description Description
Criginator - Originator
Scrambling  Enable @ Scrambling  Enable
Key scrambling Key
Video Encoder vc2_encoder! - Video Encoder
Enable @ Enable
Destination IP address 225001 Destination |P address
Destination UDP port 1000 Destination UDP port
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3. Scroll down and locate the AUX section.
4. Click the Source drop-down list and select serial_port2.
AUX Source Not used « AlX Source
MNot used
SAVE Commands SAVE
serial_pori1
Comao D

5. Enable the auxiliary (AUX) channel by clicking the Enable toggle switch. When the auxiliary channel is enabled,
this toggle switch will be orange.

6. Enter the IP address of the decoder in the Destination IP Address field. This is the decoder to which the IR
emitter is connected. In this example, the decoder IP address is 10.20.200.141.

7. Enter the port number in the Destination UDP Port field.

8. Click the SAVE button to commit changes.

TTL 255 TTL
DSCP Best effort « DSCP
FEC enable O FEC enable
FEC rows 4 FEC rows
FEC columns 4 FEC columns
AUX Source serial_port2 « AUX Source
Enable @
Destination IP address 10.20.200.141 S
Destination UDP port 1200
DSCP Best effort « Name
Bidirectional O Interface
Listen port 1204 EncGroup  Enable
SAP Enable
Scrambling Enable

OmniStream
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Configuring the Decoder Serial Port

1. Select the desired decoder within the AMS Device List window and make note of the decoder IP address.

2. Enter the required login credentials. The default login is:

Username: admin
Password: Atlona

3. Click the Login button, then click IP Input in the top menu bar.

AT O

< System information SAP Serial HDMI Output Logo Text Alarms Network

4. Scroll down to the Input 5 window group.

5. Enable Input 5 by clicking the Enable toggle switch. When enabled, this toggle switch will be orange.

6. Enter the port in the Port field. This port number must be the same port used by the encoder, and is the input of
the decoder that will receive IR data.

ﬂ IMPORTANT: Do not change the contents of the Multicast Address field. This field should be left
blank if using unicast IR.

7. Click the SAVE button to commit changes.

Name ip_inputs
Enable @
Interface eth1 «
Multicast address
Multicast Mode exclude «
filter

Addresses*

*Separate muifiple IP addresses with a comma.

Port 1200

SAVE
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8. Click Serial in the top menu bar.

AT LOMNAA

< System information SAP

HDMI Output

Logo Text Alarmms Network

9. Locate the Serial port configuration window group. The Name field, within this group, should read serial_

port2. Click the Modes drop-down list and select Infrared.

10. Click the SAVE button to commit changes.

i Serial port configuration

serial_port1 Name
seria Supported modes
serial « Mode
9600
8 w

infrared

11. Scroll down the page and locate the Serial Configuration window group. The Name field, within this group,

should read serial_use2.
12. Click the Port drop-down list and select serial_port2.
13. Click the Mode drop-down list and select output.

14. Click the Input drop-down list and select ip_input5.

Serial configuration

Command: Display Off

Name serial_use2
Port serial_port2 -
Mode output
Input ip_input5 =
Bidirectional Interface Not used
ip_input1
Destination
IP address ip_input2
Destination ip_input3
HP por ip_input4
Enabled

Mode
ASCI

HEX

SAVE DELE

Command: Display On

Mode

ASCI

OmniStream
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15. Click the SAVE button to commit changes.

Serial configuration Command: Display Off
Name serial_use2 Mode
Port serial_port2 - ASCI
Mode output « HEX
Input ip_inputs =
o SAVE DELE|
Bidirectional Interface — =
Destination
IP address
Destination 5004 Command: Display On
UDP port
Mode
Enabled O
ASCI
HEX
A, —
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Testing IR Functionality

1. Point IR remote to at the IR Receiver, as shown in the diagram below.

2. The IR remote will now sent IR data to the decoder where it will be relayed to the display device.

ﬂ IMPORTANT: The IR lens of the emitter must be within 1 inch (2.54 centimeters) of the IR window
on the display device. If this distance is exceeded, then IR functionality may fail.

/
Less than /9
<

or equal to 1 in. (2.54 cm)

AT-OMNI-121
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Controlling the Display using a Control System

The following steps are similar to Controlling the Display using the Display’s IR Remote (page 36), except that the
control system wiring should be used, instead of an IR receiver, as shown below.

Blu-ray Player

Control System

%
AT-OMNI-111 \:%,

IR Signal

—_—

Network Switch
Display

AT-OMNI-121
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USB to IP Adapter

OmniStream AT-OMNI-311 and AT-OMNI-324 provide a way to connect USB devices (such as cameras, MICs, etc)

over IP.
BluRay Player
/7044/
Media Player
AT-OMNI-324
AT-HDVS-CAM
Decoder
AT-OMNI-311
2
Decoder
Display
Display
1. Find the AT-OMNI-311 and AT-OMNI-324 in the left navigation, left click the :, and select reconnect from the drop
down menu.
£l Hepv
« AMS Device List SCAN NETWORK a8 3
" ~ fl NAME 'MODEL P MAC FIRMWARE UPDATE SITE BUILDING ROOM
[ i i 8:98:B0:01:A5: 122
B8 cuiing 1 o
° .
& o v :
() NFS21 102020 8:80
@ reon R
@ Vel 1L Bl c
.
= Uresined o
@  Velocily Video Wall ELOCITY-VIDEO A Build
WAL # ATOME-ST31
Fmeen . Reconnect
) CHECK (& % Not
v rcanm
o Y cHECK & ot Assign Notas{ @ AT.OME-SW32
Py CHECK (@  NotAssigned  NotAs Re-sync
) CHECK (& ssigne NotAs] @ AT-OMMI-111
A cHECK @ pssigned Nt Firmware Update
Y 1.0.00 cHECK & Notasd @ ATLOMMI-121
» sromi . e _
@ AT-OMNI21 V'e'-’\" LUqS
° CE© ned NoUAs| @ AT-OMINI-238
' ° Not
o - Move Device
L4 £l Nl @ AT-OMNI-311: 00:1B:13:02:AD:8C
g [ T-OMN - " Not
T B . —
¥ ATOMNI324 001B1302aces | Delete Device o

NOTE: Reconnecting the unit before adjusting it will ensure the units will be available in the pairing drop
down menu.




a PaNpuIT company

USB to IP Adapter

2. Select either AT-OMNI-311 or AT-OMNI-324 from the device list. Pairing can be done from either unit, so the
following step will show settings updating through OmniStream 311.

DEVICE INFO

Device Info

ATOMNI-311: 00:18:13:02AD:8C

Mode!
ATOMNI-311

o,

1P Addess
~ 10.20.200.61

MAC Addre
00:1B:13:02:AD:8C

3. *Optional* The units will be set to DHCP by default. Select Network to adjust the network setting to static mode.

DEVICE INFO NETWORK PAIRING

DHCP Mode
DHCP

==
4. *Optional* Select Static from the DHCP Mode drop down and fill in the IP Address, Subnet, and Default Gateway.
e.g. 192.168.1.54, 255.255.255.0, and 192.168.1.1
5. Select Pairing from the top navigation. These following steps will be the same on either the AT-OMNI-311 or AT-

OMNI-324.

DEVICE INFO NETWORK PAIRING

OmniStream 311
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6. Select the unit to pair to from the drop down menu. The OmniStream 311 can pair with up to 7 devices, the
OmniStream 324 can pair with only 1. It does not matter which drop down is used on the AT-OMNI-311 as it will
assign it to any port.

7. Press the SAVE button once the device has been selected.

PAIRING

Paiing
_ ATOVNISEID20200C0 (AT OVNISEL 019 102ACES (mec U EISCRACED) pared to-hone)
Paring
None
Pai
Non
AT-OMNI-324: 10.20 200,66 (AT-OMNI-324: 00:18:13:02AC:88) (mac: 00:18:13:02:AC88) (paired to - None)
Pei
None Non
Pai
Non
Pei
Non
Pai
Non
ATOMNI-311: 10.20.200.61 (AT-OMNI-311: 00:1B:13:02AD:8C) (mac: 00:1B:13:02AD:8C)

8. The devices are now paired. Repeat steps 5 to 7 for all the OmniStream 311s and OmniStream 324s.
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IP to Analog Audio Bridge

OmniStream 238 can be set up and routed using the Dante Controller. To download the software, go to http:/www.
audinate.com. The software will be found under products > software > Dante Controller. The download button is
found on the right side of the page. Follow the instructions for downloading.

Once downloaded and installed, the AT-OMNI-238 will be automatically detected as long as the PC running Dante
Controller and OmniStream 238 are on the same network.

NOTE: By default the AT-OMNI-238 will have AES67 disabled and will need it enabled to route the AES67
audio from the OmniStream Encoders.

Media Player

Decoder

Display
AT-OMNI-238

Speakers

1. Open the Dante Controller application.

2. Double click the OMNI238 under the Dante Receivers. A new window will open.

@ Dante Controller - Network View - o x @ Dante Controller - Device View (OMNI238-121728) - [m] X
File Device View Help File Device View Help
RN E ) e & s HBEBREG for235-1217... 19 e
Routing Device Info  Clock Status _ Network Status _Events — e T
[ o
Clear Al a Danb' L Receive Channels Available Channels
Device Lock o g% Channel Signal | Connected to Status
Filter Transmitters a8 #-239.69.0.2 @ session1
tee cHoL 018239.69.0.2 (/] "
‘Sample Rate E83 -239.69.0.4 @ session2
£48 CHo2 02239.69.0.2 []
B Sync to External E
Fiter Receivers g gg o3 [N
& Latency ‘— | CHo4
@ Subscriptions = cHos 018225.0.0.2 [S)
z CHos
Tx Multicast Flows 2 e FrTY ©
AESE7 = CHO8
e
] w & = pante " CHos
+/0MNI238-121728 o HE ~ cH10 01€225.0.0.2 [S)
cHiL
cH12
CH13
CH14
CH15
cH1s
v
< >
el Unmanaged Multicast Bandwidth: 0 bps Eventlog: fil Clock Status Monitor: []
Unsubscribe Flows: 20f 32
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IP to Analog Audio Bridge

3. Select AES67 Config from the middle navigation.

@ Dante Controller - Device View (OMNI238-121728) - o X @ Dante Controller - Device View (OMNI238-121728) - o X
File Device View Help File Device View Help
[ [ad
a1 1 al OMNI238-1217... . e ol 11 o OMNI238-1217... )
Receive Status Latency Device Config Network Config AES67 Config Receive Status Latency Device Config Network Config AES67 Config
AES67 Mod AES67 Mode

Current: _Disabled Current: Disabled
Ne New: B

‘This device must be rebooted for the changes to take effect.

Tx Multicast Address Prefi ——————————————— -Tx Multicast Address Prefix
Current Prefix: Not Set Current Prefix: Not Set
New Address Prefix: set New Address Prefix: set
Reset De Reset D
[ I Reboot 1 Clear Config I [ Reboot Clear Config

4. Select the New: drop down field and select Enabled. A pop up will appear.

& Dante Controller - Device View (OMNI238-121728) - [m) X
& Dante Controller X e beree o e
& = o
Are you sure you want to enable AES67 mode for OMNI238-121728? | 1 1 1G] - «
This device must be rebooted for the changes to take effect. el iohe sty OSvbe ConND Nk Cnl| 42567 Cont

AES67 Mode

Current:  Enabled
New: |Enabled

Tx Multicast Address Prefix

Current Prefix:  239.69.XXX.XXX
New Address Prefix: Set

Reset De
[ (" Reboot 3 Clear Config

5. Select the Yes button to confirm the switch to AES67 enabled.

6. Press the Reboot button to restart the AT-OMNI-238 and finish enabling AES67. A new pop up will appear.

& Dante Controller Warning X

Are you sure you want to reboot OMNI238-121728?

=]l w

7. Select the Yes button to confirm the reboot.

The software will return to the home screen when the reboot is finished. AES67 sources will appear as source options
for the AT-OMNI-238 in the routing menu once the reboot is finished.
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IP to Analog Audio Bridge

@ Dante Controller - Network View - a X
File Device View Help
I ) Grand Master Clock: Unknown Device™ e
Routing Device Info Clock Status Network Status Events
T T
Clear Al Da 3 E-uB=
@Dante §s8 558
Device Lock g g
Filter Transmitters e 8 H
Sample Rate IR -]
Es s
Sync to Exteral E & &
Fiter Receivers - -
Latency [— i E E
=
Subscriptions 2
]
Tx Multicast Flows h g
AES67 =
H
Sample Rate Pull-up -+ [~ Dante Receivers
— OMNI238-121728 = = a
=1.16
CHoL 9 9
CHo2 /] 9
CHO3
cHo4
cHos & &
CHO6
cHo7 (SR
CHO8
CHO9
cHI0 & &
CH11
CH12
CH13
14
cHis
CH16
v
< 53
el Unmanaged Multicast Bandwidth: 0bps Eventlog: il Clock Status Monitor:

8. Open the streams with the + buttons next to the OmniStream 238 and the multicast addresses of the
OmniStream audio streams.

9. Select the cross section squares to route the streams. The streams will only appear as green checks when audio
is passing.

NOTE: Audio paths will only show green if there is an active audio signal passing. If there is no active
audio passing the connection will show a red icon.

Audio routing should be complete and audio passing.
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Video Walls

After the basic configuration of the devices is finished, the optional video wall can be set up using the room view. The
following steps will provide the simplest way to set up a video wall.

BluRay Player

4
u
Media Player

Encoder

A, Wy

Decoder

0, Wy

S

Video Wall

1. Select the = button from the top left corner and select Sites.

2 Dashboard
2 Dashboard

< Users
7= lisees ¥  Devices >
# Devices » ®  Sites »
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Video Walls

2. Select All from the options that becomes available. A new window will appear.
= 0 Hepy ®

® Site List®

‘There are no sites found

3. Press the orange + button in the bottom right hand corner to add a site. A popup window will appear.

Import Via JSON? Or Add Via Form?

/ T

Add Via Form
Import and Upload

4. Select the purple Add via Form button for new sites or the blue Import and Upload button if loading a site
based off a previously saved site. A new window will appear or a browse folder will open.

Import Via JSON? Or Add Via Form?

@ Site Add

> ThiEPC > BXS(F) > BoxSync > Velocity Base

A N
B

v
12 Bexsyne

4 Onedrve

5]

1 ThispC
 Autodesk 360

VirtualBox51.18-11402-Win
VirtuslBox51.22-115125-Win

»
»
S|
2
B
bl
5

° cor - Foor T (Copy)en <] [anries

oo ]  Site Add

=
Q
»
»
L

2
2
5
E]

oo -l oo <] [airie -« 1 .
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e Name - Usually the company name, use to identify the site AMS will be located.
e Multiple Building slider - Select this to start the site with two buildings instead of one.

e Address 1 & 2, City, State/Province, Country, Post code - Used to help determine the exact location of the
site, to help when troubleshooting or if there is more than one site with the same name.

e Upload custom image slider - Select this option to add a custom image for the site.

o NOTE: Custom images must be .PNG, .JPG, .JPEG, or .BMP file types to display.| g

* Site/Building image drop down menu - Select an AMS site image. | =~
6. Press the Create Site button. ;

A new page will open.

7. Select the Edit Room Technology button. A new page will open.

b MOdIfy ROOm All Sites » A » Building 1 » Large Conference Room

= Technology

8. Press either the large + in the center or the small + in the top right corner of the Technology header. A new menu
will slide open on the left side of the screen.

9. Type Video Wall into the search bar and press enter.

10. Select the Add button next to the Velocity-Video-Wall when it appears.

B § e A

X Technology (All)

X Technology (All)

Video Wal| Search ) SEARCH CLEAR

Equipment

Atlona: Miscellaneous: Velocity Video Wall: VELOCITY-
@ VIDEO-WALL Al

Internal

veldiciry

OmniStream
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Video Walls

11. Press the Clear button located next to the search.

12. Select the Networked (Unassigned) label, this will expand the field.

13. Add all the OmniStream devices associated with the Video Wall.

14. Click outside of the menu, or select the X at the top to return to the room.

15. Select the Edit button (circled below) on the Video Wall. The Video Wall configurator screen will open.

X Technology (All)

> Networked (Room Assigned)

> Networked (Unassigned)

- F] _— »
g g g g
g <] S S
| I | | |
) @ C @ ) o C @

Search @)  SEARCH CLEAR
Equipment

AT-OMNI-121

OmniStream Single-Channel Networked AV Decoder

AT-OMNI-521

OmniStream R-Type Single-Channel Networked AV Decoder

AT-OMNI111

OmniStream Single-Channel Networked AV Encoder

AT-OMNI-521

OmniStream R-Type Single-Channel Networked AV Decoder

W B § 5L wModify ROOM  AliSites» A» Building 1 » Large Conference Room
= Technology +
. (= TR - NN - ®
veideiry
ATOMNII21 ATOMNI221 ATOMNIS21 1 oty o Wl
1020200123 1020200131 To20200138
@ @ @
10.20.200.139  pinging W = 2
’ ] ’ ] @ o 8 ®
102020093 pingng B
1020200175  pingng W
10.20.200.133  pingng B

16. Select the Edit button. A new pop up window will appear.

e Alias - Provide an Alias for the Video Wall.

¢ Lock Pixel Space - This locks and unlocks the resolution of the video wall. By default this is enabled. Dis-

able to select a custom size and resolution in the Pixel Space Dimensions area.

e Allow custom drop zones slider - Select this to allow the creation of custom drop zones.
¢ Pixel Space Dimensions - When unlocked, the resolution of the video wall can be selected here.

AODREMANING IOENTIEY

Video Wall Configuration ID- 5c6f69a0e04d940ca87c2649

- PixelSpace  [J It m

VideoWall

Pixel Space Dimensions

SIZETO DEVICES.

cLose
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Video Walls

17. Double click or drag and drop the wanted decoders from the Displays area. Only drag and drop the decoders
that will be used for the video wall.

18. Auto arrange the displays by dragging a mouse over the grid to the correct display layout and left clicking.

Video Wall Configuration ID- 5c6f69a0e04d940ca87c2649 x Video Wall Configuration ID- 5¢6f69a0e04d940ca87c2649

Displays ~ PixelSpace [ 3 m m A ® /s & O- B e ~ Dieplays ® PixelSpace [ & = ®é\l/¢\o—a--~
7 X Auto Amange (2x1) 7 x
Qsromn Kroun221:2 ArouN1z21 1
e Toz0zmo 13 mEO ey
I 7% [nmm sl
o sz - f252
ooood
Qo (=]
‘‘‘‘‘ -
L o O O et T =
o (=}

19. Select the Preset button (circled below) to have sources and presets become available for selection and adding.

20. The sources will not be selectable until a preset has been added, press the ADD button (circled below) in the
Presets field. A pop up will appear.

21. Name the preset and press the enter key to close or select the close button.

22. Add as many presets as needed.

Video Wall Configuration ID- 5c6f69a0e04d940ca87c2649
Preset Edit
Sowens A PixelSpace c@- o€ |88 /s & O- B =~
m AT-OMNI-521:1 AT-OMNI-122 1:1
= otz Tozm a0 :
new
-
= CLOSE
-
- X Video Wall Configuration ID- 5¢702dfee04d940ca87cf70c
oz 12 =
e N oz sz sowces N PxelSpace ) i m O B E /@ O0- B e ~
m AFOMNI-521:1 AT-OMNI-121:1
Tos020013
rowzz12 oz
proses A oz 200101 Toznzongan

23. Select the source and drag and drop it into the decoders. The source will appear over one of the displays as a
different colored square.

Video Wall Configuration ID- 5¢702dfee04d940ca87cf70c x Video Wall Configuration ID- 5¢702dfee04d940ca87cf70c

Sources ~ PixelSpace D 2 m D E B8 § /s a &- B e~

“AToMNSZIY “ATOMNLTZI 7 AToMNLZIY
102020095, To20200 130 1020200139
ATOMNI-1121:0
(225003:1000)
-
ATOWNTZ2 12 ArouNIZ2 11 ATOMN1Z212 ArouNi2211
020200131 presets ~ 1020200131 1020200131

A0 DEETE COPY e a0 omeTe copy
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Video Walls

24. Select the source square and arrange it over the decoders it should display on. Placing it centered over
intersecting lines will have it fill up all the connected decoders.

Video Wall Configuration ID- 5¢702dfee04d940ca87cf70c x Video Wall Configuration ID- 5¢702dfee04d940ca87cf70c

Sowrces - Pielspace O 5 1= 2 E BN /s & |6 B w ~ Sources ~ PielSpace ) 3t ® P E &8/ & & B =~
V e = —
i n
25. Repeat for each configuration needed.
Video Wall Configuration ID- 5¢702dfee04d940ca87cf70c NOTE: The preset being Curr’ently set iS
oo o flosem B0 o@ o aje-(@®~ -~ highlighted in blue on the left.
ATOMNI-52 7 x 7%
i e e NOTE: Multiple sources can be used in a

preset, each will show up in different colors.

oz
T
- .
n "
T 0]

DT ADD DELETE COPY

If the video wall picture is satisfactory, continue with step 26. If picture adjustment is needed to compensate for the
display’s bezel, continue to step 27.
26. Select the save button (circled above) and exit out of the configuration screen once complete.

27. Select the edit button (circled below) on the top right of the display field. A pop up will appear.

28. Select the Bezel Compensation tab.

Pixel Space [ 2 ) = A § /7 a4 O- B = ~
= AT-OMNI-521 AT-OMNI-521
<

ATOMNI121:1
1020200139 LocATION N BEZEL COMPENSATION

ATOMNISZ1:1
102020093

ATOMNI1221:2 ATOMNHIZ21:1
1020200131 1020200131

Rotation

Rotate 180 degrees

cLose cLose
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29. Select the Enable slider to allow for bezel compensation. The bezel fields will unlock.

30. Type or use the arrows to adjust the bezel pixel size in each area that requires compensation. e.g. If the display is
in the top left of the video wall, the right and bottom bezel should be compensated for.

AT-OMNI-521 AT-OMNI-521
Enabl o Enable ®
] :
CLOSE CLOSE

NOTE: If wanting to adjust the bezel in a format other than pixel, return to the device view within the device
list from configuration and open the HDMI OUTPUT tab. Scroll to the under the Video Wall slider and select
the unit type for adjustment (Pixels, Millimeters, or Inches). Select the SHOW ADVANCED button, then
select Bezel Compensation from the Edge Compensation drop down and then enter the correct amount,
before pressing the save button.

Video deo Wall
Video Wall
,,,,, 3 1P Input 1 (Video 1) Enable: ®
Enable:
Unit: Pixels
D 1921
oR ° Display Width 1920 Display Height: 100
d Keep Aspect Ratio
0
Display Height: 1080
uto 0
S e ps Horizontal 0 B 0
Audio I 0
Vertical y satior - .
N oot o 1) Edge Compensation. Bezel Compensation
Audio 1 Rotation (): 90 = 0
9 Ner Bot 0
Edge Compensation None
Left 0
Mute Mute [
Volume “ 15 @ Fasl Switching Enable [ ] Right 0
SHOW ADVANCED + TO PRIMARY T0 BACKUP Fast Swilching Enable [ ]
m TopriARY il TO BACKUP
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